
Lotus Sound Help Index
Lotus Sound lets you create, edit, and save sounds as wave files. Lotus Sound also lets you 
copy a sound to an OLE client application as an embedded or linked sound object.
You create, play, and change a sound with sound recording and play controls in the Lotus 
Sound control panel. You save and copy a sound and perform other activities by using the 
File, Edit, and Options commands in the Lotus Sound main menu.
This Help Index lists topics that describe Lotus Sound controls, commands, and other 
features and topics that explain how to perform activities in Lotus Sound. To see the text for
an Index topic, click the topic, or press TAB until the topic you want is highlighted and then 
press ENTER.
To display this Help Index from Lotus Sound, choose Help in the main menu; then choose 
Index.
To display Help text for a command, highlight the command on the command menu and 
press F1; to display Help text for a command dialog box, select the Help button in the dialog 
box or press F1.
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Sound Recording and Play Controls
When you run Lotus Sound from the Windows Program Manager, all basic recording and 
play controls are displayed and ready for you to use. When you run Lotus Sound from an 
OLE client application, all controls, play controls only, or no controls are displayed, 
depending on what you set with Options Preferences.
The following recording and play controls are available in Lotus Sound.
Slider

The slider indicates the current position of a sound. You can use the slider to move to 
another point in the sound while the sound is playing or paused.
To move to another point in the sound, click the slider or drag the slider thumb. When 
you press Record, Lotus Sound starts recording where the slider thumb is located.

Memory gauge
When you are recording a sound, the memory gauge replaces the slider in the control 
panel. The memory gauge indicates how much of the available memory the recorded 
sound is using.

Play/Pause
Click Play/Pause to play or stop playing a sound.

Stop
When you are recording a sound, Stop replaces Play/Pause in the control panel. Click 
Stop to stop recording.

Rew/FF
Click or click and hold Rew to move backward in a sound; click or click and hold FF to 
move forward in a sound.

Home/End
When you hold down SHIFT, Home replaces Rew in the control panel, and End replaces FF.
Click Home to go to the beginning of a sound; click End to go to the end of a sound.

Step
When you hold down CTRL, Step replaces Rew and FF in the control panel. Click the Step 
forward button to move forward one-tenth of a second in a sound; click the Step 
backward button to move backward one-tenth of a second in a sound.

Close
Click Close to exit Lotus Sound. Lotus Sound prompts you to save an unsaved sound 
before exiting.

Record
Click Record to record a sound, beginning at the point in the sound where the slider 
thumb is located. You can also click Record to stop recording.

Current
When you are playing a sound, Current indicates how much of the sound has played, in 
minutes, seconds, and tenths of seconds.
When you are recording a sound, Current indicates the elapsed time of the recording.

Total
Total indicates the total duration of the sound.

Max
When you are recording a sound, Max replaces Total in the control panel. Max indicates 
the maximum recording time available.
This amount varies depending on the sound quality selected in Options Preferences 
Recording Quality and on the amount of free memory in your system. The greatest 



available recording time is approximately 1 minute 35 seconds.
Erase

Click Erase to erase a sound from memory. Erase does not erase the sound file from disk.
To restore an erased sound, use Edit Undo Erase.

Level
When you are playing a sound, Level indicates how soft or loud the sound is.
When you are recording a sound, Level indicates how soft or loud the recording is. If you 
don't see the level moving while you are recording, you must increase the volume of 
your source sound. If Level stays completely lighted, you must decrease the volume of 
your source sound.

Volume
When you are playing a sound, click the Volume slider or drag the Volume slider thumb 
to increase or decrease volume. If the Volume control is grayed out, your sound board 
does not allow software control of volume.
This control does not affect recording level.



Playing a Sound
Use Play/Pause in the Lotus Sound control panel to play and stop playing the current sound.
To start Lotus Sound and play a sound embedded or linked in an OLE client application, 
double-click the Lotus Sound icon in the application. Whether you can then control playback
depends on the controls you set in Options Preferences.



Erasing a Sound
Use Erase in the Lotus Sound control panel to erase the current sound from memory, but 
not from disk. Erase does not prompt you to save an unsaved sound before erasing it.
1. Make sure that the current sound is the sound you want to erase.
2. Select Erase.
To restore the erased sound, choose Edit Undo Erase before you use another command or 
perform another activity in Lotus Sound.



Changing a Sound
When running Lotus Sound from the Windows Program Manager, change the current sound 
by recording onto the sound, by deleting part of a sound, or by erasing the sound and 
recording a new sound.
For information about changing a sound when running Lotus Sound from an OLE client 
application, see Reading a Sound File into an Embedded Sound and Updating an Embedded 
Sound.

To record onto an existing sound:
1. In the current sound, drag the sound slider thumb to the right, press and hold FF (Fast 

Forward) until you reach the point at which you want to begin recording onto the sound, 
or press HOME or END to go to the beginning or end of the sound. 
You can record onto the end of the sound, or you can record over the sound beginning at
any point. When you start recording at a point in the sound, the sound from that point to 
the end is replaced by the new sound.

2. Press Record.
3. Begin recording.
To save the new sound when running from the Windows Program Manager, choose File Save
As or File Save.
To update an embedded sound in the client application, use File Update.

To delete part of a sound:
To delete sound from any point in the sound to the end of the sound, move the slider thumb
to the place where you want to begin deleting, and then press Record twice.

To erase a sound and record a new sound:
See Erasing a Sound and Creating a New Sound.



Embedding a Sound in Lotus Notes and Ami Pro
You can use Lotus Sound to embed a sound in an OLE client application in two ways. You 
can run Lotus Sound from the Windows Program Manager, create or open a sound, and then
copy and paste the sound into the client application. Or you can run Lotus Sound from the 
client application, create or read a sound, and then embed the sound in the application.
The following instructions for embedding a sound in Lotus Notes and in Ami Pro show you 
both ways of using Lotus Sound with client applications.

To embed a sound in Lotus Notes, Version 2.0:
1. Run Lotus Sound from the Windows Program Manager.
2. Record a new sound, or use File Open to open a sound in a file on disk.
3. Choose Edit Copy Sound as an Object to copy the sound to the Clipboard.
4. Switch to Notes, and open or create the document you want to embed the sound in.
5. Click the place in the document where you want to embed the sound.
6. Select Paste Special from the Notes Edit menu.

Notes displays the Edit Paste Special dialog box.
7. Select the check box for Start DDE Link.
8. Select OK.
The sound is embedded in the Notes document, and a Lotus Sound icon is displayed. To play
the sound, double-click the icon, and then press Play in the Lotus Sound control panel.

To embed a sound in Ami Pro, Release 2.0:
1. In Ami Pro, choose Edit Insert New Object.

Ami Pro displays the Edit Insert New Object dialog box.
2. In the Object type list box, select Lotus Sound.

Note: If Lotus Sound is installed in Windows, but is not listed, reinstall Ami Pro so that 
Ami Pro recognizes Lotus Sound as a registered server in your system.

3. Select OK.
4. When Lotus Sound is running, record a new sound or use File Read to read a sound from 

a file on disk.
5. Choose Exit and Return from the Lotus Sound File menu.
The sound is embedded and a Lotus Sound icon is displayed in the Ami Pro document. To 
play the sound, double-click the icon.



File Commands
Use File commands to save, open, and update sounds and to close the Lotus Sound 
application.

New
Allows you to record a new sound.
If an unsaved sound is open when you choose this command, Lotus Sound prompts you to 
save the open sound.
See Creating a New Sound

Open
Opens an existing wave file.
This command appears on the File menu when you open Lotus Sound from the Windows 
Program Manager.
See Opening a Sound File

Read
Makes the contents of a wave file the current sound.
This command appears on the File menu when you run Lotus Sound from an embedded 
sound in an OLE client application.
See Reading a Sound File into an Embedded Sound

Save
Saves the current sound in the existing wave file of the same name.
This command appears on the File menu when you open Lotus Sound from the Windows 
Program Manager.
If this is the first time you are saving the sound, Lotus Sound prompts you to specify a file 
name.
See Saving a Sound File

Update
Updates a sound object in an OLE client application.
This command appears on the File menu when you open Lotus Sound from an OLE client 
application.
See Updating an Embedded Sound

Save As
Saves the current sound as a wave file on disk, using the name you supply.
See Saving a Sound File

Exit
Closes Lotus Sound.
This command appears on the File menu when you run Lotus Sound from the Windows 
Program Manager.



If the current sound is unsaved, Lotus Sound prompts you to save the sound before exiting.
See Exiting Lotus Sound

Exit and Return
Closes Lotus Sound in an OLE client application and returns you to the client document from
which you accessed Lotus Sound.
This command appears on the File menu when you open Lotus Sound in an OLE client 
application.
If you exit from an embedded sound object that has been changed but not updated, Lotus 
Sound prompts you to update the sound object in the client application before exiting.
See Exiting Lotus Sound



Edit Commands
Use Edit commands to restore an erased sound and to embed or link a sound in an OLE 
client application.

Undo Erase
Restores the last sound erased with the Erase button.
To undo an erase, you must use Undo Erase before you choose another command or 
perform another activity in Lotus Sound.
See Undoing an Erase

Copy Sound as an Object
Copies the current sound and OLE link information to the Clipboard so that you can paste 
the sound into a client application as an embedded sound or a linked sound.
To paste the sound as a link, you must save the sound in a file on disk before you copy it.
See Copying Sound and Link Information



Options Commands
Use Options commands to view information about an open sound, to control how Lotus 
Sound runs from an OLE client application, and to set the recording quality for new sounds.

Sound Info
Displays information about the current sound.
See Viewing Sound Information

Preferences
Controls how Lotus Sound runs from OLE client applications and controls the recording 
quality for new sounds.
See Setting Preferences for Running Lotus Sound and Changing Recording Quality



Control Menu Commands
Use Control menu commands to move, minimize, restore, and close the Lotus Sound 
window and to switch to another Windows application. Use Control menu commands in a 
dialog box to move and close the dialog box.

Restore
Returns a minimized window to its original size and position.

Move
Repositions the window or dialog box.

Minimize
Reduces the Lotus Sound window to an icon. Lotus Sound remains active and continues to 
play sound.

Close
Closes the dialog box or the Lotus Sound application.
See Command Accelerator Keys and Exiting Lotus Sound

Switch To
Displays the Windows Task List, which you can use to switch to another Windows 
application.
See Command Accelerator Keys



Creating a New Sound
Use File New to create a new sound. If an unsaved sound is open when you choose File New,
Lotus Sound prompts you to save the sound in a file on disk before closing the sound.
You can also press Record in the Lotus Sound control panel to create a new sound.

To create a new sound with File New:
1. Choose File New.

If Lotus Sound prompts you to save changes to the current sound, select one of the 
following options:
Yes
Displays the File Save As dialog box so that you can save the changes before closing the 
sound.
No
Closes the sound without saving the changes.
Cancel
Does not close the sound.

2. To create the new sound, press Record and begin recording.
Lotus Sound creates the new sound in memory. To save the sound in a file on disk, choose 
File Save As.

To create a new sound with Record:
Before you begin to record, save the current sound if you don't want to lose it. The new 
sound records onto the existing sound, beginning where the slider thumb is located.
1. Press Record.
2. Begin recording.
To save the sound in a file on disk, choose File Save As.

See also Changing a Sound



Opening a Sound File
When running Lotus Sound from the Windows Program Manager, use File Open to open an 
existing wave file. Wave files are the only sound files you can open in Lotus Sound.
To open a sound embedded or linked in an OLE client application, double-click the Lotus 
Sound icon displayed in the application.

To open a sound file with File Open:
1. Choose File Open.

Lotus Sound displays the File Open dialog box and, by default, lists the .WAV files in the 
current directory. You can display all files in the current directory by selecting All Files 
from the List Files of Type drop-down box.

2. Specify the name of the file you want to open.
You can edit the file name in the File Name text box, or you can use the File Name and 
Directories list boxes and the Drives drop-down box to select the file you want.

3. Select OK.
When Lotus Sound reads the sound file into memory, you can play or change the sound.

See also Playing a Sound and Changing a Sound



Reading a Sound File into an Embedded Sound
When running Lotus Sound from a sound embedded in an OLE client application, use File 
Read to make the contents of a wave file the current sound.
1. Choose File Read.

Lotus Sound displays the File Read dialog box and, by default, lists the .WAV files in the 
current directory. You can display all files in the current directory by selecting All Files 
from the List Files of Type drop-down box.

2. Specify the name of the file you want to read from.
You can edit the file name in the File Name text box, or you can use the File Name and 
Directories list boxes and the Drives drop-down box to select the file you want.

3. Select OK.
After Lotus Sound reads the sound from disk, you can play or change the sound.

See also Playing a Sound, Changing a Sound, and Updating an Embedded Sound



Saving a Sound File
When running Lotus Sound from the Windows Program Manager, use File Save As to save 
the current sound as a wave file on disk, using the name you supply.
Or use File Save to save changes to an existing sound file.

To save a file using File Save As:
1. Choose File Save As

Lotus Sound displays the current file name in the File Name text box.
2. Specify a name in the File Name text box. Lotus Sound assigns the .WAV extension to the

file unless you specify a different extension.
You can edit the current file name in the File Name text box, or you can use the File 
Name and Directories list boxes and the Drives drop-down box to select the file you 
want.

3. To create a description for the file, enter up to 128 characters of text in the Description 
text box.

4. Select OK.
If, in step 2, you specify a file name that already exists, Lotus Sound asks whether you want
to cancel saving the new file or replace the data in the existing file with the new data.

To save a file using File Save:
1. Choose File Save.
If you are saving an existing file, Lotus Sound updates the contents of the file on disk.
If you are saving a new file, Lotus Sound prompts you to specify a file name.

See also Creating a New Sound



Updating an Embedded Sound
When running Lotus Sound from a sound object embedded in an OLE client application, use 
File Update to change the sound object in the application.
1. Choose File Update.
When you update the embedded sound object, changes made to the sound are stored in 
memory, not saved to disk. The changes are embedded in the client application and can be 
saved as part of the application.

See also Changing a Sound and Copying Sound and Link Information



Exiting Lotus Sound
When running Lotus Sound from the Windows Program Manager, use File Exit to exit Lotus 
Sound.
When running Lotus Sound from a sound embedded or linked in an OLE client application, 
use File Exit and Return (or press ESC) to exit Lotus Sound and return to the client document.
You can also press Close in the Lotus Sound control panel to exit Lotus Sound or to exit 
Lotus Sound and return to the client document.

To exit Lotus Sound:
1. Choose File Exit.

If Lotus Sound prompts you to save changes to the current sound, select one of the 
following options:
Yes
Displays the File Save As dialog box so that you can save the changes before exiting 
Lotus Sound.
No
Exits Lotus Sound without saving the changes.
Cancel
Does not exit Lotus Sound.

To exit Lotus Sound and return to the client document:
1. Choose File Exit and Return.

If Lotus Sound prompts you to update the current sound, select one of the following 
options:
Yes
Updates the sound in the client document, exits Lotus Sound, and returns you to the 
client document.
No
Exits Lotus Sound and returns you to the client document without updating the sound.
Cancel
Does not update the sound or exit Lotus Sound.

See also Saving a Sound File



Undoing an Erase
Use Edit Undo Erase to restore the last sound erased from memory with the Erase button. 
You cannot use Edit Undo Erase to restore a sound that you record over.
Note: After you erase a sound, you can restore it only if you choose Edit Undo Erase before 
you use another command or perform another activity in Lotus Sound.

To undo an erase:
1. Choose Edit Undo Erase.
Lotus Sound restores the sound so that you can continue to record or play it.

See also Sound Recording and Play Controls



Copying Sound and Link Information
Use Edit Copy Sound as an Object when you want to copy or link a sound in an OLE client 
application. Edit Copy Sound as an Object copies the current sound and link information to 
the Clipboard.
You can then use commands in the client application to embed or link the sound in the 
application.

To copy a sound and link information:
1. Make sure the sound you want to copy is open in Lotus Sound.

If you want to link the sound, also make sure the sound is saved as a wave file on disk. 
You cannot link an unsaved sound to a client application.

2. Choose Edit Copy Sound as an Object.
Lotus Sound copies the sound and link information to the Clipboard.

Embedded and linked sounds
When you embed or link a sound in an OLE client application, a Lotus Sound object icon is 
displayed where the sound or link is pasted. You double-click the icon to start Lotus Sound 
and play the sound.
An embedded sound does not change unless you change it in the client application.
A linked sound reflects changes in the sound file on disk, so you always hear the most 
recently saved sound whenever you play a linked sound.
See also Embedding a Sound in Lotus Notes and Ami Pro and Updating an Embedded Sound



Viewing Sound Information
Use Options Sound Info to view information about the current sound.
Information about the current sound also appears in the File Open dialog box, and in the 
Lotus Sound control panel when you play or record a sound.

To view information for the current sound:
1. Choose Options Sound Info.

Lotus Sound displays the following information for the sound:
Sample Rate
Determines the frequency range and quality of a sound. The higher the sample rate, the 
greater the range, the higher the sound quality, the greater the memory required to play
the sound, and the greater the disk space required to save the sound.
Sample Size
Affects the amount of digital noise in the sound. The larger the sample size, the less the 
digital noise and the greater the sound quality.
Channels
Determines whether the sound uses 1 (Mono) or 2 (Stereo) channels.
Total Size
The size of the sound in bytes.

2. Select OK.
To change recording quality for subsequent recorded sounds, use Options Preferences 
Recording Quality.



Setting Preferences for Running Lotus Sound
Use Options Preferences to control how Lotus Sound runs from OLE client applications and 
to set recording quality for subsequent sounds. These preferences apply to Lotus Sound 
(and all sounds played through it), not just to the current sound.

To set preferences for Lotus Sound in client applications:
1. Choose Options Preferences.
2. Select one of the following to control how Lotus Sound runs when you play a sound 

embedded or linked in a client application:
Show all controls
All Lotus Sound play and record controls are displayed when you play the sound in the 
client application. You can use the controls to play, change, and update the sound.
Show play controls only
The Lotus Sound play controls are displayed when you play the sound from the client 
application. You can use the controls to play and replay the sound and to move backward
and forward in the sound.
Hide all controls
No Lotus Sound controls are displayed when you play the sound in a client application, 
and the mouse pointer displays as a sound speaker.
To stop playing a sound when no controls are displayed, you click the left mouse button 
or press ESC.

3. To have the Lotus Sound window close when it is finished playing a sound in a client 
application, select the check box for Close window when sound is finished.
Note: Lotus Sound closes when a sound is finished only if you play the sound all the way
through without pausing. If you pause the sound, the window does not close when the 
sound is finished.

4. Select OK.
For information about playing a sound in a client application, see Playing a Sound. For 
information about embedding or linking a sound, see Copying Sound and Link Information.

To set recording quality for subsequent sounds:
Select Change... to display a list of recording qualities and to select the values you want to 
use when recording subsequent sounds.



Changing Recording Quality
Use Options Preferences Change to set recording quality for subsequent sounds and to see 
the total bytes used per second when recording a sound with that quality. The sound board 
you are using determines which recording options are available.

To change recording quality:
1. Choose Options Preferences.

The Options Preferences dialog box is displayed.
2. Select Change....
3. Select a rate in the Sample Rate drop-down box.

The sample rate determines the frequency range and quality of a sound. The higher the 
sample rate, the greater the range, the higher the sound quality, the greater the 
memory required to play the sound, and the greater the disk space required to save the 
sound.

4. Select a sample size in the Sample Size drop-down box.
The sample size affects the amount of digital noise in the sound. The larger the sample 
size, the less the digital noise and the greater the sound quality.

5. Select channels in the Channels drop-down box.
The available channels are 1 (Mono) or 2 (Stereo).

6. Select OK.
The Options Preferences dialog box is redisplayed.

7. Select OK.
Information about a sound appears in the File Open dialog box when you open the sound 
file, and in the Lotus Sound control panel    and the Options Sound Info dialog box when you 
play or record the sound.



Record and Play Keys
You can use the following keys to control sound recording and playback.
Space bar

Toggles between Play and Pause, or stops recording a sound.
HOME or SHIFT+LEFT

Moves to the beginning of a sound.
END or SHIFT+RIGHT

Moves to the end of a sound.
ESC

Closes Lotus Sound from an OLE client application.
LEFT

Rewinds a sound.
RIGHT

Fast forwards through a sound.
CTRL+LEFT

Steps backward through a sound.
CTRL+RIGHT

Steps forward through a sound.
R

Toggles between Record and Stop.
E or X

Erases a sound.
UP

Increases volume if your sound board allows software control of volume.
DOWN

Decreases volume if your sound board allows software control of volume.



Command Accelerator Keys
You can use the following keys instead of commands to perform tasks in Lotus Sound.
ALT+F4

Prompts you to save an unsaved sound and exits Lotus Sound. ALT+F4 is equivalent to 
Exit in the File menu and Close in the Control menu, to double-clicking the control menu 
box, and to selecting the Lotus Sound Close button.
You can also use ALT+F4 to close the Help window or a dialog box.

CTRL+Z or ALT+BKSP
Restores the sound you last erased. CTRL+Z or ALT+BKSP is equivalent to Undo Erase in the 
Edit menu.

CTRL+ESC
Displays the Windows Task List so you can switch to another Windows application. 
CTRL+ESC is equivalent to Switch To in the Control menu.

CTRL+C or CTRL+INS
Copies sound and link information to the Clipboard so that you can then embed the 
sound in -- or link it to -- an OLE client application. CTRL+C or CTRL+INS is equivalent to 
Copy Sound as an Object in the Edit menu.



Control Menu Keys
You can use the following keys to move, size, and close windows and dialog boxes and to 
access other open Windows applications.
ALT+ ESC

Cycles through open Windows applications.
ALT+F4

Prompts you to save an unsaved sound and exits Lotus Sound. ALT+F4 is equivalent to 
Exit in the File menu and Close in the Control menu, to double-clicking the control menu 
box, and to selecting the Lotus Sound Close button.
You can also use ALT+F4 to close the Help window or a dialog box.

ALT+ space bar
Opens the Control menu.

CTRL+ESC
Displays the Windows Task List so you can switch to another Windows application. 
CTRL+ESC is equivalent to Switch To in the Control menu.



Dialog Box Keys
You can use the following keys to move and close the dialog box, and move around and 
select options in a dialog box. 
ALT+ a letter

Selects the option or command with the underlined letter that you press.
ALT+F4

Closes the dialog box without completing the command. This is equivalent to selecting 
Cancel.

ALT+ space bar
Opens the Control menu for the dialog box. The Control menu contains commands to 
move and close the dialog box.

ALT+UP or ALT+DN 
Opens and closes the drop-down box associated with a selected option in a dialog box.

END
Selects the last item in a drop-down box or list box. 

ENTER
Completes the command and closes the dialog box.

ESC
Closes the dialog box without completing the command. This is equivalent to selecting 
Cancel.

HOME
Selects the first item in a drop-down box or list box.

PG UP or PG DN
Moves to the top or bottom item in the list of items currently visible in a drop-down box 
or list box, and selects the item.

SHIFT+TAB
Moves backward to the previous option, from bottom to top and right to left.

TAB
Moves forward to the next option, from left to right and top to bottom.

UP, DOWN, LEFT, RIGHT
Move within a group of options.



When No Sound Is Playing
To record and play sound, a sound board must be installed in your computer. If a sound 
board is installed and you still cannot play sound, do the following:
1. Check to make sure that:

* A speaker is plugged into the sound board and turned on.
* Volume is set loud enough.

Use the volume-control knob on your sound board to set sound to a comfortable 
level.
If your sound board supports software control of volume, you can also adjust volume 
by adjusting the Volume control in the Lotus Sound control panel. If the Volume 
control is grayed out, your sound board does not allow software control of volume.

2. Then try this:
Select the Sound option from the Windows Control Panel. If the Test button is grayed out,
and you have a sound card installed, there is an address or interrupt conflict with your 
sound card or the sound drivers are not properly installed. Check the sound card 
documentation for information about the I/O address, the interrupt vector (IRQ), the DMA
channel, and driver installation.
Make the necessary changes and run Windows again.



check box
In a dialog box, the box that turns the associated option on and off. When an X appears in 
the box, the option is on. When the box is blank, the option is off. When the box is filled, 
Lotus Sound cannot determine the state of the option for the current selection.
To change the check box for a selected option, click the check box, press the space bar, or 
press the underlined letter. 



click
To press the mouse button and release it.



Clipboard
A temporary storage area used by Windows to copy information from one location to 
another. Lotus Sound uses the Clipboard to temporarily store data when you use Edit Copy 
Sound as an Object.



command
An instruction you give Lotus Sound. Commands are listed in menus and appear as buttons 
in dialog boxes.To complete some commands, you choose commands from menus and 
select options and enter specific information in dialog boxes.
If an ... (ellipsis) follows the command name, a dialog box appears when you choose the 
command. If an arrowhead follows the command name, a cascade menu appears when you 
choose the command.



Control menu box

The box located in the left corner of the top line of a window or dialog box. The Control menu
displays commands for moving, sizing, and closing the window, and for switching to another 
Windows application. The Control menu in a dialog box lets you move and close the box.



current directory
The directory that Lotus Sound automatically uses during a session to save, read, or list 
files. The current directory is the directory from which you started Lotus Sound.



current sound
The sound you are playing or recording in Lotus Sound.



dialog box
A window that requests information needed to carry out a command. When Lotus Sound 
displays a dialog box, you must complete it or cancel it before you can go to any other task.
When a dialog box component is not available, it is dimmed.



double-click
To press and release the mouse button twice, quickly.



drag
To press the mouse button and hold it while moving the mouse.



drop-down box
In a dialog box, a box that shows a single option until you select the scroll arrow to the right 
of the option; then a list of options drops down. Some drop-down boxes let you enter text in 
the top box; in others, you must select an option from the list.



extension
At the end of a file name, a . (period) followed by up to three characters. When Lotus Sound 
creates a sound file, it automatically adds the extension .WAV. You can override this 
extension by entering a different extension when you save the file.



file name
The name you use when you save or open a file. A file name can be up to eight characters 
long and can contain letters (A through Z), numbers (0 through 9), _ (underscores), and - 
(hyphens).



icon
A small picture that represents an available option, operation, or application (such as a 
minimized Lotus Sound window). Select an icon to perform specific tasks.



link
A connection between two files that lets the files share data.
You can link a sound file to another Windows application that supports OLE (Object Linking 
and Embedding) using Edit Copy Sound as an Object. 



list box
A list of choices that appears in a dialog box. If there are more choices than can fit in the 
visible area of the list box, use the scroll bar or the arrow keys to bring the other choices 
into view.



OLE (Object Linking and Embedding)
Links data between files. Use Edit Copy Sound as an Object to link a sound file and a file in 
an OLE client application.



save
To copy a file from memory to disk.



select
To highlight or specify commands on a menu or options in a dialog box.



specify
To select from the items in a list box or enter a new item by typing.



text box
A rectangular area in some dialog boxes in which you enter information and edit text 
required by a command.



wave file
A file that stores digitized sound. By default, the file extension .WAV is assigned to a wave 
file created in Lotus Sound.



window
The area of the screen in which you can view your work. The title bar in the active window is
always highlighted. Several windows can be open, but only one window at a time can be 
active.


